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Chapter 1  
 
Accessing Sitecore 

Sitecore provides browser based interfaces which allow content authors, administrators, 

developers, and other interested parties to create and maintain a web site.  Users access 

the interfaces via the Sitecore login page.  The login page requests a Sitecore username and 
password and provides options which allow the users to influence which interface they access and 

how it will be displayed. This Document 

1.1 Customizing the Login Page 

1.1.1 Accessing the login page 

The Sitecore login page can be accessed by typing sitecore at the end of the base URL for the 
site.  For example, if the site URL is:  

http://www.mysite.com/    

Then users may access the Sitecore login page via:    

http://www.mysite.com/sitecore    

http://www.mysite.com/
http://www.mysite.com/sitecore
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The login page is shown below. 

 

The areas marked with letters have the following functionality: 

A. Login/Advanced switch. 

This area contains two buttons, Login and Advanced. They change the Activity Interface 

view. 

B. Login form.  

 
Enter your login (user name) and password and click the green button to login. 

 

Note: The username is case insensitive, while the password is case sensitive. It means 

that if a username is Claire, then the user will be successfully logged in as claire. 
However, if the password is MyPassword, then mypassword will not work. 
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Note: Sitecore will remember the last username and other options provided. 

 
Users should click the green arrow button to submit the username and password for 

verification. 

C. Activity Interface selector 

a. Login View  

 
This view allows users to choose whether they want to edit the site content in 

WebEdit mode or via the Content Editor. 

b. Advanced View 

 
In the Advanced view users can select the user interface, browser display mode 
and the client language. 
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D. License and version information. 

This section provides information about the current installation, including the exact 
release of Sitecore that is running 

E. Browser notes. 

This section contains important notes concerning the browser used and other important 
notices. 

1.2 Browser Display Mode 

Browser Display Mode has three options which are Normal, Without Toolbars and Fullscreen (see 

below).  

 

These options directly affect the view of the Sitecore client when users login, and are described in 
the following section. 

1.2.1 Browser Display Mode 

1.2.1.1 Normal 

The screenshot below shows the Normal browser display mode. 
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Note: The Internet browser toolbar(s) and the Windows taskbar are visible when Sitecore is 

started in this mode.  

1.2.1.2 Without Toolbars 

If users choose to start Sitecore in the Without Toolbars display mode, it will be opened in a new 
window and will appear without the Internet Explorer toolbars, as is shown in the screenshot 

below. 

 

The user will then be prompted to close the existing window or login to Sitecore (see the 
screenshot below).  
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1.2.1.3 Fullscreen 

The Fullscreen Display Mode will prompt Sitecore to open in a full screen window, as it is shown 

in the screenshot below: 

 

To close the window when running in Fullscreen mode, users should press Alt+F4. A screen will 
then be shown which allows users to either close the window or log back in to Sitecore (see 

screenshot below). 
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1.2.2 Client Language 

The Client Language option allows the user to select the language in which the client 
functionality is displayed. 

Note: The client language selection affects only the language in which buttons and descriptions 

are displayed in the interface. The content language, however, is managed separately.  
Administrators can specify the default content language on a per-user (via the Edit User dialog in 

the User Manager) or per-site basis (via the shell site element in the web.config file). 

The screenshot below shows the dropdown list of the client languages available in Sitecore. 

 

Note: Some of the languages may not have complete translations; English versions will be shown 
in cases where a translation is unavailable. 

Default means that the client language set in the User Properties for a username provided is set. 

The default client language for all users in Sitecore is English. However, it is possible to change 
the default language for a certain user. To do that, follow the steps below: 

 Open the User Manager by clicking on Sitecore » Security Tools » User Manager (see 

below). 
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 Open the folder where the user is located, then select the user you wish to edit, then either 

click Edit in the Users chunk or double click the user and the Edit user dialog box will 

open (see below). 

  

In the Edit user window, locate the Client Language field and change the field value (see 

the screenshot below). 

 

Now if Pam selects Default in the Client Language dropdown list of the Sitecore Client login 

page, the client functionality for this user will be displayed in Danish.  
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1.3 Common Errors 

Unknown User or Password Errors 

 

The Unknown user or password error occurs if the invalid username or password has been 

submitted for verification. If this error is received, ensure that the Caps Lock button is turned off.  

Note: Remember that the username is case insensitive, whilst the password is case sensitive. 
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Chapter 2  
 
Authoring Content 

The Editor is the person responsible for creating new content, editing existing content, and 

providing regular maintenance of the information on the website. The Editor is often the primary 

source of keeping information up to date and maintaining the high quality of the content. 
However, other user roles, such as the Webmaster or Administrator, may also be involved in 

content maintenance.  

2.1 The Content Editor 

The Content Editor interface provides a multitude of features that allow users to create and 
maintain the content of a web site. The Content Editor in combination with two extra applications, 

the Media Library and the Workbox, gives the user full control over the site content. The Content 
Editor styling and functionality are inspired by Office 2007 and allow editors to simultaneously 

use the system and have the editing options at hand. This document describes how to perform 

typical tasks in the Content Editor. 

2.2 Creating New Content 

Follow the steps below to create new items and fill them with content: 

Open the Content Editor by selecting Sitecore menu » Content Editor (see the screenshot below). 
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Select the desired parent node of the new item in the content tree. 

Right-click the parent node and select the New option from the menu which will appear. In the 
New menu, select the type of the new item to be created (see the screenshot below). 

 

Note: The type of items available in the New menu will vary from item to item, depending on 

how your site is configured. In the example below, the New menu for one of the Contacts 
subitems contains the Contact person item type (see the screenshot below). 

 

In the dialog which will open, enter the name of the new item and select the “OK” button (see the 

screenshot below). 
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Note: Sitecore has a list of invalid characters that are verified at this stage. Therefore it is 

recommended that users name items using either A-Z, a-z, 0-9 and _ as valid characters. 

 

The new item is now created and appears in the content tree of the Content Editor (see the 
screenshot below).  
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2.3 Editing Content 

To modify content in a certain content item, open the Content Editor and select the appropriate 
item in the content tree. The content of the selected item will appear in the Data section of the 

Content Editor (see the screenshot below).  

 

2.4 Using The Rich Text Editor 

Initially, the Rich Text Editor is not displayed. To display the Rich Text Editor and be able to 
modify content, select the Show Editor button available when hovering over the Text field or 

simply double-click inside the Text field (see the screenshot below).   
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When clicked, the Show Editor button will open the Rich Text Editor in a new window. You can 

now modify the content (see the screenshot below).  

 

By selecting the Accept button in the right-hand bottom corner of the Rich Text Editor dialog, 

you accept the modifications to the text and close the Rich Text Editor window. The changes to 

the content will immediately be visible in the Text field of the Content Editor (see the screenshot 
below).  
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The Rich Text Editor supports a variety of text formatting options, such as bold, italics, text color, 

highlighting, superscript, and subscript. The Rich Text Editor provides a range of powerful 
features besides formatting, such as table management, undo and redo options, direct HTML 

editing, and many more.   

To learn more about editing content please read the chapter titled Editing Content 

2.5 Saving Content 

Remember to always save the changes made to any content. By saving your work regularly, you 
ensure that you only lose relatively few changes if the network connection goes down, if power is 

lost, or under any other circumstances which might cause the loss of unsaved data.  

There are two ways to save content in the Content Editor. You may save your changes with the 

Save button available on the Ribbon or use the keyboard shortcut <Ctrl+S>.  

2.6 Using Links 

Links offer a way of referring to other material on the Internet or on another web page. A link can 
lead to a source on the same website or a source on another website. 

2.6.1 Creating a Link 

2.6.1.1 Inserting a Link into Existing Text  

To insert a link into already existing text open the appropriate content in the Rich Text Editor and 
highlight the text to be used as the link text. 

2.6.1.1.1 To Create an External Link (referring to another source on the Internet):  

Select the Hyperlink Manager button  available in the upper toolbar and the Hyperlink 
Manager dialog will appear. Fill in the fields with the appropriate values and click the OK button 

(see the screenshot below).  

 

Note: You may also create an internal link via the Hyperlink Manager following the same 
procedure.  

2.6.1.1.2 To Create an Internal Link (referring to a source on the same website): 
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Select the Insert Link button  available in the upper toolbar and the Insert a Link dialog will 

appear. The Insert a Link dialog allows linking to another item (select the Internal Link tab) or a 
media item (select the Media Items tab).  

In the content tree, select the item the link should lead to and click the Link button in the right-

hand bottom corner of the dialog (see the screenshot below).  

 

The newly created link will appear in the appropriate formatting (blue and underlined, as shown 

below)  

 

2.6.1.2 Creating a Link without the Initial Text     

Creating a link without the initial text is almost identical to inserting a link into already existing 
text. Follow the steps below to create a link without the initial text:  

 Place the cursor where the link should be inserted. 
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 Select the Hyperlink Manager button  available in the upper toolbar and the 

Hyperlink Manager dialog will appear. Fill in the fields with the appropriate values and 
click OK.  Notice the Link Text which becomes available in the dialog when you create a 

link without the initial text (see the screenshot below).  

 

2.6.2 Creating Anchor Links 

Anchor links help users navigate sections of a long page by taking them directly to a particular 

area of a page. An anchor link is comprised of two elements: the link itself and the anchor on the 
target page.    

Follow the steps below to add an anchor link:   

 Put the cursor before the word you want to anchor TO on the target page.  

 Select the Hyperlink Manager button ( ) available in the toolbar and the dialog window 

will appear.  

 In the dialog window, select the Anchor tab, enter the name of the anchor link into the 

appropriate field (no spaces in the name) and click the OK button (see the screenshot 

below): 

 

 Select the text you want to link to the anchor FROM.  
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 In the toolbar select the Insert Sitecore Link button ( ) » Internal Link tab. In the Insert a 

Link dialog window which will appear, select the item with the anchor and click the Link 

button at the bottom of the window (see the screenshot below).  

 

 As a result you will get linked text. Now we need to modify the link so that it points to 

the anchor.  

 Select the link you have just created and click the Hyperlink Manager button available in 

the toolbar ( ).  

 In the URL field of the Hyperlink tab add the # symbol with the anchor name right after 

the link. Then click OK (see the screenshot below): 

 

 The anchor link is now created.  
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2.7 Using Images 

Although the product accepts image data as part of the site design or layout, images may also be 
embedded into the text as part of the content. All the images are uploaded to the Media Library 

and are stored there. This section describes various ways of using and manipulating images after 

they have been uploaded to the Media Library.  

The content does not have to be all text. Adding one or more images to spice up the text can be 

easily done in the Rich Text Editor. The image does not have to be placed in one position only.  

Follow the steps below to insert an image:  

 Open the Rich Text Editor and place cursor where the image should be inserted.  

 Select the Insert Media button  available on the upper toolbar and the Insert Media 

Item dialog will appear.  

 In the dialog, select the image you wish to insert and click the Insert button at the bottom 

of the dialog (see the screenshot below).  
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 The image is now placed at the cursor position and the text is positioned accordingly (see 

the screenshot below).  

 

Refer to the Managing an Image section of this article to learn how to manage the image.  

Note: You must upload the image before you can use it in your content. 

2.7.1 Managing an Image 

Right-click the image and a menu with two options will appear (see the screenshot below).   
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2.7.2 Set Image Properties 

Select this option to set image properties. When selected, the Set Image Properties option will 
open the Image Properties dialog (see the screenshot below).  

 

The Image Properties tab allows you to set or change the following options:  

 Border Width – Used to set the border width.  

 Border Color – Used to set the border color.  

 Image Alt Text – Used to set the text displayed when the image is unavailable and the 

mouse hovers over the image.  

 Note: The text defaults to the upload directory. Often you might want to change the text 

so that it describes the image in the best way.  

 Long Description – Used for disabled users.  

 Image Alignment – Used to align the image.  

 Image Src – Used to set the URL to the image stored in the Media Library.  

 Horizontal Spacing – Used to set the space between the image and the surrounding text in 

the horizontal direction, that is, the space between the image and the text on the right/left 

side. The value is set in pixels and defaults to 0 (no spacing between text and image).  

 Vertical Spacing – Used to set the space between the image and the surrounding text in 

the vertical direction, that is, the space between the image and the text at the top/bottom 
of the image. The value is set in pixels defaulting to 0.  
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 Width – Used to set the image width.  

 Height – Used to set the image height.   

2.7.3 Image Map Editor 

Select this option to open the Image Map Editor. When selected, this option will open the Image 

Map Editor in a new window (see the screenshot below). 

   

Select the Create Area button (see the screenshot above) to create a new Area.  

When selected, the Create Area button will open the Selected Area Properties (see the screenshot 

below). Fill in the fields and click the Update Area button.  
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2.8 Using Tables 

This section deals with how to create and manage tables in the Rich Text Editor with ease and 
minimum effort.  

2.8.1 Inserting a Table 

The Rich Text Editor offers two ways to create a table. For basic tables we recommend the click-
and-drag Table Builder, while for more complex tables the Table Wizard is more appropriate. 

However, you are welcome to choose the approach which suits your needs and preferences the 

most.  

2.8.1.1 The Table Builder 

Inserting tables with the Table Builder could not be easier.  

Follow the steps below to insert a table using the Table Builder:  

 In the Rich Text Editor, place the cursor where the table should be inserted and select the 

Insert Table button  available in the upper toolbar and the drop down Table Builder 
will appear (see the screenshot below).  

 



 

Sitecore Using Sitecore Page 27 of 119 
Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2007 Sitecore. All rights reserved. 

 Select the desired number of rows and columns by dragging the mouse over the grid (see 

the screenshot below) and click inside the grid.  

 

 The table appears in the Rich Text Editor at the insertion point.  

2.8.1.2 The Table Wizard 

To create a table using the Table Wizard, follow the steps below:  

 Position the cursor where you want to create a table.  

 Click the Insert Table button  available on the editor toolbar.  

 Select the Table Wizard button on the Table Builder dialog (see the screenshot below). 
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and the Table Wizard dialog will appear (see the screenshot below).  

 

You can now use the Table Wizard dialog to create a table and set its properties.  

2.8.1.3 The Table Design  

The Table Design tab has options for changing the table design: adding/deleting columns and 
rows, merging/splitting cells and rows.  

 
Select - or + to remove or add columns.  

 
Select + to merge the right cell with the cell you have selected. Select - 

to unmerge the left cell. 

 

Select - or + to remove or add rows. 
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Select + to merge the right row with the row you have selected. Select - 

to unmerge the left cell. 

 

Select to create the defined table. 

You can further customize this table using the Table Properties, Cell Properties, and Accessibility 
tabs of the Table Wizard dialog.  

Refer to the next section, Managing Tables, to further learn how to modify tables. 

2.8.2 Managing Tables 

You can edit a table after it has been created. The Rich Text Editor allows you to insert or delete 
rows, columns and cells, merge cells horizontally or vertically, split cells, set cell properties, and 

show or hide table border.  

Right-click the table and the context menu with the options which allow you to show/hide the 
table border, set table properties or delete the table will appear (see the screenshot below).     
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Right-click inside a cell and the context menu with the options which allow you to manage cells, 

rows and columns will appear (see the screenshot below).     

 

You can also access these options by selecting the Insert Table button  available in the 
upper toolbar (see the screenshot below).  
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2.8.2.1 Setting Table Properties 

The Rich Text Editor allows changing table properties after the table has been created. To change 

table properties of a new or existing table, right-click the table and select the Set Table Properties 
option from the context menu which will appear (see the screenshot below).   

 

Alternatively, you may select the Set Table Properties button  available on the Table Builder 
dialog.    

Yet another way of setting table properties is selecting the Table Wizard button from the Table 

Builder dialog.   

 

When selected, the Set Table Properties option will open the Table Wizard dialog, which allows 

you to change table design, set table and cell properties, or adjust accessibility according to your 
needs. 
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Select the Table Properties tab to set or change table properties (see the screenshot below).   

 

The Table Properties tab allows you to set the appearance of the table. The table properties are 
explained below:  

 Width – Use to set the width of the table in pixels or percent.  

 Height – Use to set the height of the table in pixels or percent.  

 Background – Use to set the background color of the table.  

 Alignment – Use to align the table to the left, center or right side of the page.  

 Cell Spacing – Use to set the space between the borders of a cell.  

 Cell Padding – Use to set the space between the content and the border of a cell.  

 ID – Use to set an ID for a table, which will give you some options for advanced table 

handling.  

 Background Image – Use to set an image as the table background.  

 CSS Class – Use to set the table CSS class and style.  

 Border – Use to set the border width, color, and layout.   

2.8.2.2 Resizing Tables 

Resize tables in the Rich Text Editor with ease and at minimum effort. The Rich Text Editor 
offers two ways to resizing tables. You may resize the existing table by specifying the table 

dimensions in the Table Properties tab or by direct drag-and-drop.  

Refer to the Setting Table Properties section to learn how to resize a table using the Table 

Properties tab.  

To resize an existing table with a drag-and-drop, do the following:  



 

Sitecore Using Sitecore Page 33 of 119 
Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2007 Sitecore. All rights reserved. 

 Click the table border and eight small squares will appear in the outer area of the table of 

the table (see the screenshot below). 

 
 

 Drag any of these handles vertically, horizontally, or diagonally to resize the table. All 

cells, which do not have exact dimensions (specified in pixels), will be resized evenly to 

accommodate the new table size.  

2.8.3 Managing Cells 

You can edit cells after the table has been created. A new cell can be added to the table; the cells 
can be split or merged; their size can be changed.  

2.8.3.1 Changing Cell Properties 

It is possible to change individual cell properties of an existing table or set cell properties while 
creating a table using the Table Wizard dialog.  

Changing Cell Properties via the Right-click Menu  

Follow the steps below to change cell properties of a new or existing table via the right-click 
menu. 
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 Right click inside the cell you wish to edit and select the Set Cell Properties option from 

the menu which will appear (see below).  

 

 Set the cell properties in the dialog which will appear and click the Update button. The 

Cell Properties dialog allows you to select content alignment, background color, change 
the cell‟s size, align background image, and select cell CSS (see the screenshot below).  

 

Changing Cell Properties Using the Table Wizard Dialog    

Follow the steps below to set or change individual cell properties using the Table Wizard dialog:   
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 Select the cell whose properties you want to change and click the Table Wizard button 

available on the Table Builder dialog (see the screenshot below).  

 

 In the Table Wizard dialog which will appear, select the Cell Properties tab and change 

the appearance of the individual cells (see the screenshot below).   

 

The Cell Properties tab allows you to set the appearance of the table. The table properties are 

explained below:   

Content Alignment – Used to align the content within the selected cell.  

Background – Used to set the background color of the selected cell.  

Height – Used to specify the height of the selected cell in pixels or percent.  
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Width – Used to specify the width of the selected cell in pixels or percent.  

ID – Used to set an ID for the selected cell, which will give additional options for improved cell 
handling for advanced users.  

No Wrapping – Used to enable/disable text wrapping (that is forcing a new line when the text 

reaches the cell border).  

Background Image – Used to set an image as the cell background.  

CSS Class – Used to specify the cell CSS class and style.  

2.8.3.2 Merging Cells 

Merging cells entails combining two separate cells into a single cell. The cursor position 

determines which cells will be merged. The cell containing the cursor will be merged with its 
neighbor by row or by column. 

Follow the steps below to merge cells horizontally.  

Note: The cell containing the cursor will be merged with its neighbor to the right. 

 Choose the cells you want to be merged and place the cursor into the appropriate cell.  

 

 

 Right click inside the cell and select the Merge Cells Horizontally option from the menu 

which will appear (see the screenshot below).  
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 You may also click the Insert Table button available on the upper toolbar  and 
select the Merge Cells Horizontally button from the Table Wizard which will appear (see 

the screenshot below). 

 

 The cells have now been merged (see the screenshot below).  

 

Follow the steps below to merge cells vertically.  

Note: The cell containing the cursor will be merged with its neighbor below. 

 Choose the cells you want to be merged and place the cursor into the appropriate cell. 
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 Right click inside the cell and select the Merge Cells Vertically option from the menu 

which will appear (see the screenshot below). 

 

 You may also click the Insert Table button available on the upper toolbar  and 

select the Merge Cells Vertically button from the Table Wizard which will appear (see the 
screenshot below).  
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 The cells have now been merged (see the screenshot below).  

 

2.8.3.3 Splitting Cells 

To split a cell that has been previously merged do the following: 

 Place the cursor inside the cell you want to split. 

 Right-click the cell to open the context menu. 

 From the menu select the Split Cell option.  

2.8.3.4 Deleting A Cell 

To delete a cell, place the cursor inside the cell to be removed, right-click the cell to display the 

context menu and select Delete Cell from the menu or select the Delete Cell button  from the 
Table Wizard dialog.   

2.8.4 Managing Columns 

Once you have created the table, you can edit the columns. The Rich Text Editor allows inserting 

and deleting columns.  

2.8.4.1 Inserting a Column 

Follow the steps below to insert a column:  

 Place the cursor where you want the column to be inserted.  

 Right-click inside the column for the context menu to appear.  

 Select Insert Column to the Left and the new column will be inserted to the left of the 

cursor or Insert Column to the Right and the new column will appear to the right of the 

cursor.  

 You may also select the Insert Column to the Left  or Insert Column to the Right 

buttons   from the Table Wizard dialog.  

2.8.4.2 Deleting a Column 

To delete a column place the cursor to the column to be removed and select the Delete Column 

button  from the Table Wizard dialog. Alternatively, you may right-click the column to be 
removed for the context menu to appear and select Delete Column from the menu.  

Note: All content available in the column will also be deleted.  
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2.8.5 Managing rows 

You can edit rows in a table once the table has been created. The Rich Text Editor allows adding 
and deleting rows.  

2.8.5.1 Inserting a Row 

Follow the steps below to insert a row to a new or existing table:  

 Place the cursor where you want to insert a row.  

 Right-click inside the row for the context menu to appear.  

 Select the Insert Row Above or Insert Row Below options from the menu (see the 

screenshot below).  

 

 You may also select the Insert Row Below  or Insert Row Above  buttons from 

the editor toolbar.  

2.8.5.2 Deleting a Row 

To delete a row, position the cursor inside the row you want to remove and select the Delete Row 

button  available on the editor toolbar and in the right-click menu: .  

Note: All the row content will also be deleted.  

To delete a row, position the cursor inside the row you want to remove and select the Delete Row 

button  available on the editor toolbar and in the right-click menu: .  

Note: All the row content will also be deleted. 
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Chapter 3  
 
Editing Content 

The editor provides a multitude of features that allow you to create and maintain the content of 

your site. It gives the user full control over site content. Styling and functionality are inspired by 

Microsoft Office 2007 and allows editors to simultaneously use the system and have the editing 
options at hand. This document describes how to use the various editor features. 

3.1 Overview 

The screenshot below shows the editor as seen by a fully privileged user; please note that some 
features and information are restricted for non-Administrator users, so the actual appearance of 

the editor for a specific user may vary. Nonetheless, the main areas of the editor described in this 

document are the same for all users. 

 

The topmost part of the Content Editor interface is the Ribbon where all the commands for editing 

content are located. To the left is the Content Tree area. Select the View tab for instructions on 
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viewing and hiding the content tree. To the right are the Item Title Bar and the Field Area. At the 

bottom is the Pages Bar which provides access to Media Library and Workbox.  

3.2 The Ribbon 

The topmost part of the Content Editor is called the Ribbon. It provides access to editing 
functionality. The Ribbon is comprised of Tabs. 

The Ribbon in the screenshot below contains tabs that provide the various content maintenance 

related commands: 

 

However, in some cases the Content Editor may display less tabs than are shown.  

In general, tabs provide groups of operation specific commands. A group of commands are called 
a Chunk, while a set of chunks is called a Strip.  

The screenshot below illustrates the terminology introduced so far:  

 

Note: Disabled commands are grayed out. The screenshot below shows the unfolded Navigate 

Chunk with the Back, Forward and Links commands disabled.  

 

Note: The tabs available for the user will depend on the user‟s assigned roles and the security 

settings for the current installation. Here we will describe options available to fully privileged 

users, also known as Administrators. If some of the functionality described here is missing in a 
specific session, the current user may not have the necessary permissions. 
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3.3 The Home Tab 

Commands provided by the Home tab allow you to manipulate the current item as a whole, such 
as copying the item, changing its position in the content tree, or creating sub-items.  

 

When selected, the Home tab displays a strip of seven chunks.  

3.3.1 The Write Chunk  

The Write chunk is always unfolded no matter which tab is activated and contains the Save 
button: 

  Select to save changes to the currently selected item.  

3.3.2 The Edit Chunk   

The Edit chunk contains the Edit button: 

   

Select Edit to lock the current item so that only you can edit it. If the button (as in the Icon 

displayed) is disabled, this may mean that someone else has the item locked, or that you do not 
have Write access rights to the item, you will also see a warning at the top of the Field list to say 

that the item is locked by another user (see screenshot below). 
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3.3.3 The New Chunk 

The New chunk contains buttons for each of the types of sub-items that you can create under the 
current item. The list will vary depending on which item is selected. If many item types are 

available, you can scroll to see additional item types.  Select the appropriate button to create a 

new sub-item of the corresponding type.  For example, select the Contact button to create a new 
Contact Item as a sub-item of the selected item (as shown below).       

  

Select the box beside the New button (shown below) to open a dialog that allows you to assign 

additional sub-item types to the list available for the current item (not available for all users).   

 

To assign an additional sub-item type to the current item, select the desired master in the left side 

of the dialog which will appear, then click the blue forward arrow button or double-click the 
desired master (as shown below). Once the master moves to the right side of the dialog, click the 

OK button at the bottom of the dialog.  

 

The newly added master will appear in the New chunk (see the screenshot below).  

 

3.3.4 The Operations Chunk  

The Operations chunk contains the Duplicate, Copy To, Move To and Delete buttons: 
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Select to duplicate the currently selected item. The client will request a name for the duplicate 

item.  

   Select to copy the item to another location. The client will request a location for 

the copy.  

   Select to move the Item to another location. Specify the desired location in the 

dialog which will appear. 

   Select to delete the current item.  

   Select to delete sub-items.   

3.3.5 The Clipboard Chunk  

The Clipboard chunk contains the Paste, Cut and Copy buttons:  

 

   Select to paste items from the Clipboard.   

   Select to cut the item and sub-items and put them on the Clipboard.  

   Select to copy the item and sub-items and put them on the Clipboard.  

3.3.6 The Rename Chunk   

The Rename chunk contains the Rename and Display Name buttons: 
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   Select to assign a new name to the item. This is the name that will be used in the 

URL required to select the item in the published web site.  

   Select to assign a new language-dependent name to the item.  

3.3.7 The Sorting Chunk  

The Sorting chunk contains the Up, Down, First and Last buttons. 

   Select the box beside the Sorting button to define how the sub-items of this 
item are sorted. In the Subitems Sorting dialog, select the desired sorting from the drop-down 

menu of the Sorting field and click the OK button. 

   

You can also reset the sort order (Sorting) field of the sub-items by clicking the Reset button at 

the bottom of the Subitems Sorting dialog.  

   Select to move the item before the previous item.  

   Select to move the item after the next item.  

   Select to move the item first.  

   Select to move the item last.  
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3.4 The Navigate Tab 

When selected, the Navigate Tab displays the Navigate and Search chunks:  

 

3.4.1  The Navigate Chunk 

The Navigate chunk contains the Open, Back, Forward, Up, Subitems, Home, Favorites and Links 

buttons.   

   Select to open the Open Item dialog box, then select the item that you wish to open and 

click Open (see the screenshot below).  

 

The Open button marked in red in the screenshot below provides an additional option. When 

clicked, it displays a contextual menu of two tabs. In addition to the Content Tree folder, the 
Recent folder lists recently visited Items:   

 

 

   Select to go to the previously selected item.  
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   Select to return to an item after having selected the Back button. 

   Select to go to the parent item.   

   Select to go to a sub-item. Then select the desired sub-item in the sub-items menu 
which will appear.   

   Select to go to the Home item.  

   Select to display your favorite items.  

   Select to show referenced and referred items. When selected, the Links button opens the 
list of referenced and referred items (see the screenshot below).  

 

3.4.2 The Search Chunk 

The Search chunk contains the Search and Find buttons (see the screenshot below).  
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   Select to open the Search application. Enter your search query into the Search field and 
click the Search button (see the screenshot below).  

 

The Search application with the search results will appear (see the screenshot below).  

   

Note: You can also locate the website content via the Search field which is available in the bottom 
right part of the Desktop Taskbar (see the screenshot below).  

 

3.5 The Review Tab 

Commands provided by this tab allow you to validate the item, perform workflow operations, or 
schedule future activities. 

When clicked, the Review tab displays the Validate, Workflow and Schedule chunks (see the 

screenshot below). 
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3.5.1 The Validate Chunk 

The Validate chunk contains the Spelling and Validate buttons:  

  

   Select to check spelling in the entire item.  

   Select to check that the HTML conforms to the XHTML standard specified by the 
W3C organization.   

3.5.2 The Workflow Chunk 

The appearance of the Workflow chunk depends on the workflow state of the current item and the 
roles the user has assigned.  Although not described here, the Workflow chunk will also display 

any workflow related commands.  Workflow related commands differ between sites; contact your 
local administrator for information about workflow commands available on your site.  

If the item is unlocked and the user has the appropriate permissions, the Workflow chunk with the 

Edit button and a prompt to click the Edit button to lock and edit the item will appear (see the 

screenshot below). 

 

If the item is locked, the user will see the Workflow chunk with the note specifying who has 

locked the item, as in the screenshot below. 

  

Note: Any user with the Administrator permissions will still be able to edit the item even if it has 

been locked by another user.  
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3.5.3 The Schedule Chunk 

The Schedule chunk contains the Reminder and the Archive buttons:   

 

   Select to set or clear the Reminder. Select the action you want to perform on the 
Select menu which will appear: 

  

   Select to archive the item. It is possible to Archive the item now, set the archive date 
or clear the archive date via this button. Select the desired option on the Archive menu which will 

appear: 

  

Retrieving items from the archive is an advanced operation not described here.  Please use this 

feature with caution. 
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3.6 The Publish Tab 

Commands provided by the Publish tab allow the user to preview and publish items, as well as 
specify publishing restrictions for the selected item. 

When clicked, the Publish tab displays the Publish and Restrictions chunks (see the screenshot 

below).  

 

3.6.1 The Publish Chunk 

The Publish chunk contains the Publish, WebEdit, Preview and Publishing Viewer options 

(see the screenshot below).  

   

   Select to publish the item.   

   Select to start the edit mode. The editing interface will open in a new window.   

   Select to start the Preview mode. The Preview interface will open in a new 

window.   

   Select to open the Publishing Viewer (see the image below) which shows 

when item‟s versions are active on the website.  
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3.6.2 The Restrictions Chunk 

The Restrictions Chunk contains the Change button:  

  

   Select to configure how an item is published. The Change Publishing Settings 

dialog will appear (see the screenshot below).   

 

The dialog allows restricting the publication of one or more versions of the current item, 

restricting the publication of the current item, and indicating the appropriate publication 

destination for the current item. Select one of the three Tabs – Versions, Item, and Targets - 
available in the dialog to perform the necessary action.  

3.7 The Versions Tab 

Commands provided by the Versions tab allow you to work with numbered and language versions 
of the item. 

When clicked, the Versions tab displays the Fields, Versions, Language and Translate chunks:   
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3.7.1 The Fields Chunk 

The Fields chunk contains the Reset button (see the screenshot below).  

   Select to reset the field values to their standard value. When selected, the Reset button 

will open the Reset Fields dialog (see the screenshot below).  

 

The Reset Fields dialog allows you to reset fields to their standard value. The left column shows 

the current value. The right column shows the value, if the field is reset.  

3.7.2 The Versions Chunk 

The Versions chunk contains the Versions, Add, Compare and Remove buttons (see the 
screenshot below). 

   

   Select to show versions of this item in the current language. Select the triangle 
beside the Versions command and the list of versions available for the current item will appear 

(see the image below).  
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   Select to add a new version.  

   Select to compare the versions of the current item for changes.  

   Select to remove the current version. Select the triangle beside the Remove 

command to display the Remove All Versions button.   

   Select to remove all versions of the current item.   

3.7.3 The Language Chunk 

The Language chunk contains the Language button 

   Select this button to choose the language to display.  

3.7.4 The Translate Chunk 

The Translate chunk contains the Translate button and the Language and Compare options:   

 

   Select to show or hide the Translate mode. Once clicked, the Translate button 
activates the Language and Compare options located in the left side of the Translate chunk, which 

were formerly deactivated and thus grayed out (see the screenshot above).  

The screenshot below displays the Translate chunk with the activated Translate mode:  
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The Language command in the screenshot above allows the user to select the language in which 

the item will be displayed, while the Compare option allows user to choose the versions to be 
compared.   

Once the Translate command is selected, the field area will change its appearance. It will be split 

into two parts so that each language version has its own set of fields (shown below). 

 

3.8 The Configure Tab 

The Configure tab contains commands which allow the user to influence various aspects of the 
item‟s configuration. 

When clicked, the Configure tab displays the Appearance, Masters, Template and Attributes 

chunks (see the screenshot below). 

 

3.8.1 The Appearance Chunk 

The Appearance chunk contains the Icon, Help, Editor Form, Tree Node Style, Contextual Tab, 
Context Menu (see the screenshot below). 
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   Select to assign an icon to the current item. Select the appropriate icon from the 

menu which will appear.  

   Select to set help texts and links for the item.   

   Select to assign a custom form for editing.   

   Select to specify the appearance of the item in the Content Tree.   

   Select to have the contextual tab in the ribbon displayed when this item is 

open.   

   Select to assign a context menu.   

3.8.2 The Masters Chunk 

The Masters chunk contains the Assign button (see the screenshot below).  

 

   Select to assign masters to the item. When clicked, the Assign button will open the 
Set Masters dialog (see the screenshot below).  

 

In the All section, select the item you wish to assign to the item, select the blue rightward arrow 
button, and click OK in the bottom right-hand corner of the dialog (see the screenshot above).  
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3.8.3 The Template Chunk 

The Template chunk contains the Change Template, Edit Template, Add Field and Delete Field 
buttons (see the screenshot below).   

 

   Select to assign another template to the item.   

   Select to open the Template Editor.   

   Select to add a new field to the template.   

   Select to delete a field from the template.   

3.8.4 The Attributes Chunk 

The Attributes chunk contains the Hide item and Protect item buttons: 

  

   Select to mark or unmark the item as hidden.   

   Select to mark or unmark the item as being protected (read-only).  

Important Note: The Protected attribute is just a UI attribute, not a core attribute. When a 

protected item is selected, the Delete button is disabled. But users can delete protected items by 
choosing Delete subitems on the parent item. 

3.9 The Presentation Tab 

The Presentation tab provides commands which allow the user to associate the item with 

presentation objects and aliases.  

When clicked, the Presentation tab displays the Layout chunk:   

  

3.9.1 The Layout Chunk 

The Layout chunk contains the Layout and Aliases buttons:     
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Select the Layout button to manage assigned layouts. In the menu which will appear, click the 

name of the layout, the icon of the device or the Edit button (see the screenshot below), and the 
Device Editor dialog will appear.   

 

Select the desired layout from the list of available layouts in the Layout field and click the OK 

button located at the bottom of the dialog (see the screenshot below).   

   

You can also add, edit, remove, and move up or down, the renderings and sub-layouts using the 

Renderings and Sublayout section and the appropriate functional commands located to the right of 

the Device Editor dialog (see the screenshot below).    
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Select the Aliases button in the Layout chunk to manage URL aliases. In the Aliases dialog which 

will appear, enter the alias‟ name in the Add input box, click the Add button to the right of the 
input box and close the dialog by clicking the Close button located in the bottom right hand 

corner of the dialog.     

 

Save and publish the changes. The new alias for the Home item has been created. You can now 

access the Home item by typing http://localhost/222.aspx into the web browser address bar.  

3.10 The Security Tab 

Commands provided by the Security tab allow you to assign access rights and restrictions.  

When clicked, the Security tab displays the Security and Presets chunks:  

 

3.10.1 The Security Chunk  

 

   Select to edit security settings.     

   Select to view access rights.    

   Select to open the user Manager.     

3.10.2 The Presets Chunk 

The Presets chunk lists various preset access right configurations. Privileged users can create 
new presets in the /sitecore/system/Security/Presets folder.  
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   Select to give read and write permissions to the user with the Editor role 

assigned.  

   Select to deny permissions to the current Item to the user with the Editor role 

assigned.     

   Select to give read right to the user with the Editor role assigned     

3.11 The View Tab 

The View tab contains commands which allow the user to influence the appearance of the Editor. 

When clicked, the View tab displays the View chunk:   

 

3.11.1 The View Chunk 

The Editor Button in the View chunk allows showing or hiding the custom editor form.   

   Check \ uncheck to show or hide the Content Tree.    

   Check to show items marked with the Hidden Items attribute. The items will 

be displayed in the Content Tree (see the screenshot below).  
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Once the Hidden Items checkbox is unchecked, the items marked with the Hidden Items attribute 

will be hidden from the Content Tree (see the screenshot below).   

 

The Standard Fields checkbox allows users to see items marked with the protected attribute.  

   Check to display items marked with the protected attribute.   

   Check to display raw field values as they are stored in the database. 

3.12  The Content Tree 

The Content Tree allows users to view the system as a tree with child items grouped under their 

parents.  

If an item has child items, a + appears next to it, as shown in the screenshot below:  

 



 

Sitecore Using Sitecore Page 63 of 119 
Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2007 Sitecore. All rights reserved. 

Click + to show the child items. Once the parent item has been expanded, a - appears next to it, as 

shown in the image below:  

 

Once a - is clicked, the child items will be hidden. 

When the user right clicks any item in the content tree, the context menu with a set of available 

commands for this item will appear. See the screenshot below for an example of a menu.  
Note: commands available on the menu will vary on a per item basis.  
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3.12.1 Changing the Appearance of the Content Tree 

It is possible to show or hide the entire Content Tree or only the Content Tree Root in the Content 
Editor.  

See the screenshot below for the view of the entire Content Tree as it appears in the Content 

Editor:  

  

To hide the Content Tree Root, click the Sitecore logo button, select the Change Options button at 

the bottom of the icon menu which will appear. 
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Go to the View tab, uncheck the Show Entire Content Tree checkbox and click the OK button.  

  

As a result, the Content Tree Root will be hidden and the user will see only the content items, as it 

is shown in the screenshot below: 

  

You may also completely hide the Content Tree. To do that, select the View tab and uncheck the 

Content Tree checkbox in the View chunk (shown below).  
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3.13  The Item Title Bar 

The Item Title Bar is located in the right side of the Content Editor Application, just below the 
Ribbon (see the screenshot below). It contains options for setting an icon for the current item, 

changing publishing settings for the current item, navigating to sections and fields, changing the 

name of the item and selecting the language and version.  

 

     Select to set a new icon to the item. You can either manually type the file name of the 
icon or browse for an icon in the Web Page Dialog which will appear (see the screenshot below). 

 

Enter the new name of the item in the User Prompt dialog which will appear (see the screenshot 

below).  
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    Select to change publishing settings for the current item. When selected, the icon will 
open the Change Publishing Settings dialog (see the screenshot below).  

 

The Change Publishing Settings dialog will allow you to restrict the publication of one or more 

versions of the current item, restrict the publication of the current item, and indicate the 

appropriate publication destination for the current item. 

  Select to open the workflow context menu with the options which allow you to check 

the workflow state of the current item, to lock the current item for editing, approve the current 

item thus moving it to next workflow state, or reject the current item thus moving it to the 

previous workflow state. 

Note: The Workflow icon appears when the current item enters a workflow. This can happen in 

two ways:  

 When you select the Edit button on an existing item that is associated with a workflow.  

 When you create a new item that is associated with a workflow (because the item is 

automatically placed in the initial state of the workflow).  

Once selected, the Workflow icon opens the workflow context menu (see the screenshot below).  

 

   Select to lock the item for edit.   

    Select to approve the item thus moving it to the next workflow state.   

    Select to reject the item thus moving it to the previous workflow state.    
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Note: Another way of accessing the workflow commands is to select the Review tab » Workflow 

chunk.      

   Select to navigate to sections and fields. Once selected, the icon will display the fields and 

sections menu (see the screenshot below). In the menu, select the section or field you wish to 

move to.  

 

  Shows which language is selected for the current item (English in our example). Click to 
choose the language for the item. The menu will display the list of available languages, as shown 

in the screenshot below:  

 

The above screenshot shows that there are four English versions and one Danish version of the 

current Item. 

To the right of the language icon, the version icon is located:    
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It shows which version of the item is currently open. When clicked, the version icon opens a 

menu with information for each of the versions available. To choose the version, click it on the 
menu: 

 

3.14  The Field Area 

The Field Area is located in the right side of the Content Editor, below the Item Title Bar and 
contains fields, which are grouped into sections (see the screenshot below).  

3.14.1 Changing the Appearance of the Field Area  

It is possible to add standard fields to the Field Area. You may do this in two ways. You may 
click the View tab on the Content Editor Ribbon and check the Standard Fields checkbox in the 

View chunk, as shown in the screenshot below:  
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You may also click the Sitecore logo button and select the Change Application Options button at 

the bottom of the logo menu which will appear.    

 

Check the Fields from the Standard Template checkbox in the dialog which will appear, as shown 

in the screenshot below:  

  

3.15  The Media Library 

The Media Library is a tool for storing, administering and uploading media files to the system. 
The Media Library allows you to handle media files of various types: images, Word documents, 

PDF files, sound files, or movie clips. The media files stored in the Media Library may be 
embedded into the website content. You may also provide links to them, which will allow the 

website visitors to download the specified media files.   
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3.15.1 Accessing the Media Library 

You may access the Media Library in two ways. You may click the Media Library button on the 
Pages Bar, which is located at the bottom of the editor window (see the screenshot below).  

  

You may also choose Media Library from the Sitecore menu (see the screenshot below).  
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Click the Media Library button and the Media Library application will open.   

3.15.2 Uploading Images 

To use media files, you need to upload them to the system first. The Upload wizard will take you 
through the upload process. You may access the Upload wizard through the Media Library by 

selecting the Media Contextual tab located on the Ribbon » the Upload chunk » the File button, as 
shown in the screenshot below:  

 

Click the File button, and the Upload a File dialog will appear. You may manually type the path 

to the item into the appropriate field in the dialog or you may click Browse and locate the 

necessary file.  

Then click the Upload button at the bottom of the dialog, which will finish the upload process.   
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You may also access the Upload wizard through the Image Editor, which you can select from the 

Sitecore menu.  

The media library also allows you to upload multiple files with advanced options. To do that open 

the Media Library and select the Media contextual tab» the Upload chunk » the Advanced button.  

   Select to upload files with advanced options. When selected, the Advanced button will 
open the Batch Upload dialog (see the screenshot below).  

 

In the dialog, select the files to upload by manually typing the paths into the appropriate fields or 

by selecting the Browse button. When done, select the upload button, which will finish the upload 
process. The newly uploaded files will appear in the Uploaded Media Items box (see the 

screenshot above).  

3.16 Workbox 

Sitecore provides functionality to ensure that the site content undergoes appropriate quality 
control measures before it is published to the website. This is enabled by workflows, which are 

state machines. Before an item can be published, it must move through a predefined set of states.  

Note: Sitecore workflows are customizable and vary on a per site basis.   

The Workbox gives a user with the appropriate rights an overview of the workflows and items 

available in different workflow states. The Workbox is organized by workflow, then workflow 

state, then the items included in each state.   
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Sitecore provides a Sample workflow that contains the Editing and Reviewing states, as shown in 

the screenshot below.  

 

An item will enter the workflow in the Editing state and may be moved to the Reviewing state by 
an author. A privileged user may then reject the changes, which move the item back to the Editing 

state, or accept them, which move the item to the Published state (not shown) and publish the 

changes.  An item only exists in one state at a time, although multiple versions of the item may 
exist in different states. 

 To the right of each of the workflow states the number of items in this workflow state is 

displayed. In our example, all the workflow states have 1 item (see below). 

 

The Workbox allows the user to see the overview of items by workflow state. To see the items 

overview, unfold the appropriate workflow state by either clicking the down arrow button in the 

right side of the workflow bar (see the screenshot below) or by clicking directly inside the 

workflow bar. Once unfolded, the workflow bar gains a reddish hue. Likewise, to fold the 
workflow bar and hide the items, click the up arrow button in the right side of the workflow bar or 

simply click inside the workflow bar.  
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3.16.1 The Menu 

The topmost part of the Workbox application contains the Manage tab, which displays the 
Workflows and View chunks (see the image below).   

  

3.16.1.1 The Workflow Chunk 

The Workflow chunk contains the Sample Workflow toggle.   

   Check to display the Sample Workflow. 

3.16.1.2 The View Chunk 

The View chunk contains the 'Items per Page' dropdown list box and the Refresh command.   

The 'Items per Page' dropdown list box allows selecting the number of items displayed on a single 

page (see the screenshot below).  

    

   Select to refresh the Workbox application. 

3.16.2 Workflow Commands 

The illustration below shows the Reviewing state which has been unfolded. In our example, there 
is only one item in the Reviewing state.   
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Right below the item‟s name is the information line, where the item‟s workflow history is 

displayed. It shows which states the item has passed and, if available, comments provided by 
users when moving the item between states.     

Below the information line, the workflow commands are located, which can be used on a per-item 

basis, on all selected items in a given state or all items in the state.    

   Select to open the item in the Preview mode.    

   Select to open the item in the Content Editor for review and edit.    

    Select to view the differences between the item versions.     

   Select to approve the item thus moving it to the next workflow state.    

   Select to reject the item thus moving it to the previous workflow state.  

3.17 Logging off the Content Editor 

To log off the Content Editor, click the red Sitecore logo button in the top left corner of the 
Content Editor (see the screenshot below).  

  

Then select the Exit Content Editor Button in the bottom right hand corner of the Sitecore icon 

menu which will appear (see the screenshot below). 
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Confirm that you want to exit the Content Editor by clicking the OK button in the dialog which 

will appear (see below). 

 

Upon clicking the OK button, the user will be logged off the Content Editor and the Sitecore 
administration and redirected to the login screen.  

You may also simply double click the Sitecore logo button to exit the Content Editor.  

3.18 Running the Content Editor as an Application 

It is possible to run the Content Editor as an application. To access the Content Editor application, 
start the Sitecore administration in the Desktop mode, click the Sitecore button located in the left 

side of the taskbar and select Content Editor on the Sitecore menu.    

 

The Content Editor application will open in a new window, which gives the user a whole set of 

advantages. The user can manage the application window - resize and place it anywhere on the 
desktop - just like a Microsoft Windows application.  

The user can make use of the various Sitecore taskbar features (which cannot be accessed if the 

user selects the Content Editor option at login). As a result, the user gets a possibility to work with 

several application windows simultaneously.   
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When clicked, the Sitecore logo button opens up the menu with the information about the 

currently selected item. The menu includes the general information as well as the information on 
statistics, workflow, archive and reminder sections. To view the information, click the downward-

pointing double arrow button which is located in the right hand corner of each section (see the 

screenshot below).   

 

To hide the information, click the upward-pointing double arrow button (see the screenshot 

below).   
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3.18.1 Information  

The Information section provides the currently selected item‟s item key, display name, item ID, 
master, and template (see the screenshot below).   

 

3.18.2 Statistics  

View the Statistics section to learn who and when created and modified the item (see the 
screenshot below).  

 

3.18.3 Workflow    

Refer to the Workflow section to view the current item‟s workflow state and learn who has locked 
the item (see the screenshot below). 

 

3.18.4 Archive  

Refer to the Archive section to view the archiving date of the current item (see the screenshot 
below).   

 

3.18.5 Reminder  

Refer to the Reminder section to view when the reminder will be sent out (see the screenshot 
below).   
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    Select to exit Content Editor; the application window will also be closed.  

    Select to change the current user options for the Content Editor, 
Rich Text Editor, and the View options 
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Chapter 4  
 
The WebEdit User Interface 

The WebEdit interface displays the website as it will appear when published, but includes content 

that has not yet been published.  WebEdit allows the user to navigate through the site using 

whatever navigation features the website itself provides.  The WebEdit interface adds 
mechanisms to the website that allow the user to modify the website as well as view it.  This 

document describes how to access WebEdit and how to use the various interface features. 

4.1 Accessing WebEdit 

You can access WebEdit in two ways. You may select the interface at login either in basic or 
advanced mode, as shown in the screenshots below. 
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You may also access WebEdit from the Sitecore menu when logged in to the Desktop (as shown 

below).  In this case, WebEdit opens in a separate browser window.  

    

4.2 Content Markers 

The green and grey dots the user will see once logged in to WebEdit are content markers which 

mark editable content. The green content markers indicate that the content is editable and the user 
has the appropriate permissions to edit this content. The grey content markers are inactive and 

indicate that though the content is editable, the current user does not have security access to this 

particular content (see the screenshot below). 
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The hover-over function also indicates whether an Item is editable. If you place the mouse over 

any content marker, text appears that either encourages you to click the dot and edit the content or 
explains that the item is currently read-only (see below).  

 

 

Right click on a green content marker to display a menu with various functions.  

 

Note: Menu options will vary from item to item depending upon the nature of the content.  

Selecting the Edit command from the popup menu or clicking a green content marker opens the 

Content Editor in a new browser window.  The Content Editor is described in the next section. 
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4.3 Content Editor 

The Content Editor displayed from WebEdit is almost identical with the Content Editor. For more 
detailed information on how to use the Content Editor please read the chapter titled Editing 

Content. 

The Content Editor displayed from WebEdit has an additional Close button (see below), which is 

not available in the Content Editor. 

 

 

Click this button to close the Content Editor. If any changes have been made but not saved then 

you will be prompted to confirm that you want to close without saving the changes (see below). 
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4.4 Floating Menu 

WebEdit contains additional commands and options located in the floating menu (see the 
screenshot below). To move the floating menu, click and hold inside the title bar and drag the 

window.  

  

4.4.1 Floating Menu Commands 

The screenshot below displays an example of the floating menu available in WebEdit.   

   

Note: The commands available on the menu will vary depending on the current users security 

access and the location within the website.  

The floating menu is divided into three sections:   
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4.4.1.1 General Commands 

The General Commands section shown in the screenshot below provides functionality to allow 

manipulation of the currently selected item.   

  

The Edit button opens up the Content Editor in a new window.  

The Open Workbox button opens up the Workbox.   

Select Delete to delete the current item.   

Selecting the Publish button will open the Publish wizard with the various publish options. 

Follow the steps in the wizard to successfully complete the publish process. 

  

Note: The Publish option will only be available to the users with the appropriate rights.  

Select Switch to Preview to switch to the Preview interface.   

Click End WebEdit to quit the WebEdit interface. Once you click the End WebEdit button, you 
will be automatically redirected to the website in normal mode.   

Upon selecting the Log Off button, the user will be logged out of WebEdit as well as the Sitecore 

administration and automatically redirected to the normal mode website. Choosing Log Off will 
also log the current user off any other Sitecore interfaces open at the moment.  For instance, if the 

user has logged into the Desktop interface, selected the WebEdit shortcut from the Sitecore menu, 

then selects Log Off from the WebEdit floating menu, the user will also be logged off of the 

Desktop interface.  
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4.4.1.2 New Item 

The New Item section allows the creation of new items via WebEdit. Developers and 

Administrators configure which types of items may be created as sub-items of any given item, so 
the list of new item types available will vary.  New items will always be created as sub-items 

under the selected item. 

  

Note: The New items displayed will vary based on which Item in the site is selected.   

4.4.1.3 Languages 

The Languages section allows you to shift between the languages supported by the website. In 

the screenshot below, four country flags are shown, which means the website is available in 
Danish, German, American English and British English.  

 

Note: The number of languages set may vary on a per site basis. The languages set for the website 

are always visible in the Languages section.   

For example, the Languages section in the screenshot below indicates that the website is available 
in Danish, English, Spanish, Norwegian, and Swedish.  
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Chapter 5  
 
The Preview Interface 

The Preview interface displays the website as it will appear when published, but includes content 

that has not yet been published, and may show the site as it will appear in the future or as it 

appeared in the past. The Preview interface allows the user to navigate through the site using 
whatever navigation features the website itself provides. This document describes how to access 

the Preview interface and how to use its various features. 

5.1 Accessing Preview 

You can access the Preview interface in two ways. You may select the interface using the 
Advanced login, as shown in the screenshot below. 
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You may also open Preview from the Sitecore menu when logged in to the Desktop client, as 

shown below.  In this case, Preview opens in a separate browser window. 

 

5.2 The Floating Menu 

The Preview interface contains additional commands located in the floating menu. The 
Preview interface menu appears in a floating window within the Preview application window. To 

move the floating menu, click and hold inside the title bar and drag the window.  

The screenshot below shows the Preview interface with the floating menu. 
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5.2.1 Floating Menu Commands 

The screenshot below displays the floating menu available in Preview. 

  

 Select to fold the floating menu. The menu will be folded, while the title bar will remain 

afloat (see the screenshot below).  

  

The floating menu is divided into two sections: General Commands and Preview Date. 

5.2.1.1 General Commands 

The General Commands section shown in the screenshot below provides functionality for 

manipulating the currently selected item. 

   

   Select to switch to the WebEdit mode.  

   Select to quit the Preview mode. Once you click the End preview button, you 

will be automatically redirected to the normal mode website.  

   Select to log out of the Preview interface. You will also be automatically 

redirected to the normal mode website. Choosing Log Off will also log the current user off any 
other Sitecore interfaces open at the moment.  For instance, if the user has logged into the 

Desktop interface, selected the Preview shortcut from the Sitecore menu, then selects Log Off 

from the Preview slide-out menu, the user will also be logged off of the Desktop interface.  
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5.2.1.2 Preview Date 

The Preview Date section allows the user to see the website as it appears on different dates. To 

view the site as it appears on a given date, select this date in the calendar located in the Preview 
date section. Previewing the site at various dates is useful when some items have publishing 

restrictions assigned.  For  more information about publishing restrictions, please read the Content 

Editor » Publish Tab » Restrictions Chunk section. 
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Chapter 6  
 
Site Administration 

Day-to-day site administration is easy with Sitecore. You can create user accounts, apply access 

rights and perform other tasks that help keep everything running smoothly. This chapter describes 

administration tasks and tools used in daily site administration. 

6.1 Item Management 

This section covers the basic principles of managing items within Sitecore. 

6.1.1 Recovering Deleted Items 

You can restore an item after it has been deleted in Sitecore. Once deleted, the item does not 
disappear permanently, but moves to the recyclebin database. To restore the deleted item, select 

the Recycle Bin from the application list (see the screenshot below).  
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Select the item you wish to restore and click the Restore Item button located on the toolbar (see 

the screenshot below).  

 

Note: Items in the Recycle Bin are stored in folders based on the deletion date: the year folder 

contains the month folders.   

The toolbar also contains the Up and Empty buttons.   

   Select to restore the item.  

   Select to empty the Recycle Bin.  

6.1.2 Viewing the Recycle Bin 

There is another way to view the contents of the Recycle Bin in Sitecore.  

Activate the Recycle Bin database by selecting the recyclebin from the database list available 

upon clicking the Switch Database icon located in the right side of the Desktop taskbar (see the 
screenshot below). 
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Note: the switch database icon on the taskbar only appears for Administrator users. 

The name of the current active database appears when you hover the cursor over the database icon 
in the bottom right corner of the Desktop interface (see below).  

 

 
 

Once in the Recycle Bin database you can open the Content Editor and select the content folder 
which will display the Recycle Bin‟s contents organized in folders (see below).     

 

 

Note: Use the Recycle Bin application to restore items. 

6.1.3 Archiving Items 

Sitecore has various options which allow the user to archive items on a predefined date or 
immediately upon selecting the option, archive a given item or select the top-level item and 

archive the whole item tree.   

To archive an item, go to the Content Editor » Review tab » Schedule chunk (see the screenshot 

below).   
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Select the Archive button to manage the archiving of the item. When selected, the Archive button 

will open the contextual menu for managing (setting and clearing) the archiving date (see the 
screenshot below).   

 

Select Archive Now to immediately archive the item. After confirming your action (see below) 

the item will immediately be archived.   

 

Select Set Archive Date to set the archive date. When selected, the option will start the Archive 

Item wizard which will help you choose the archive date.  

Follow the steps below to set the archive date.  
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Select Next for the wizard to proceed (see the screenshot below).  

 

 

Enter the archive date into the Date field by selecting the date from the calendar and click Next to 
complete the wizard (see the screenshot below).  

 

Once complete select Finish to close the dialog.   

The archive date for the Item has now been set (see the screenshot below).   
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Select Clear Archive Date to clear the archive date. Once selected, the Clear Archive Date option 

will notify you that the archive date has been cleared. Select OK to close the window (see the 

screenshot below).  

 

6.1.3.1 Viewing the Archive Database 

Follow the steps below to access the Archive database: 

Activate the Archive database by clicking the Database icon located in the right side of the 

Desktop taskbar and selecting the archive option from the list of available databases (see the 
screenshot below). 

 
 

The name of the current active database appears when you hover the cursor over the database icon 

in the bottom right corner of the Desktop interface (see below). 

 

Open the Content Editor and locate the content folder.  
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Items in the Archive database are stored according to the archiving date.  

Note: Use the Archive date field of the Tasks section in the Content Editor to archive items. Items 
are stored in a different format in the Archive from those in the Master databases. You will not be 

able to restore items by directly transferring them from the Archive database to the Master 

database.  

6.1.4 Setting Reminders 

Set reminders in Sitecore and you will be notified of anything you wish on a predefined date. 
Administrators can set reminders not only for themselves but also for other staff members, which 

is certainly a plus in a busy working environment.   

To set a reminder, go to the Content Editor » Review tab » Schedule chunk (see below).   

 

Select the Reminder button to manage the reminder. When selected, the Reminder button will 

open the contextual menu for managing (setting and clearing) the reminder. The menu will also 
display the date and time of the set reminders, if there are any, or otherwise indicate that no 

reminders have been set (see the screenshot below).  

 

Select Set Reminder to configure a new reminder. Once selected, the Set Reminder option will 

open the Set Reminder wizard which will help you enter the reminder text, choose a reminder 
date and a set of recipients. Click Next for the wizard to proceed.   

Enter the reminder text and click Next (see the screenshot below).   
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Select the date of the reminder and the recipients of the reminder, then click Next to set the 

reminder (see below).    

 

Click Finish to close the window.  

To view the reminder details (the date on which the reminder will be sent), select Review tab » 

Schedule chunk » Reminder (see the screenshot below). 

   

Select Clear Reminder to clear the reminder. Once selected, the Clear Reminder option will 
remove the reminder and notify you by opening the notification window (see the screenshot 

below).  

 

Click OK to close the window.  The reminder has now been cleared.  

6.1.5 Manipulating Items 

This section will introduce you to the some of the basic actions involved in working with items 
that you will regularly perform once you start working with Sitecore. You will learn how to copy, 

duplicate, move, delete, rename and sort items in Sitecore. These are the easiest, yet the most 
often used commands. Once you learn these commands, you are sure to grasp the idea behind 

other Sitecore commands. For the sake of simplicity, we will stay within the Content Editor to 

describe the commands.  
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6.1.5.1 Copying Items 

Sitecore offers several ways of copying an item. 

6.1.5.1.1 Via the Copy To Command  

Open the Content Editor and locate Home tab » Operations chunk » Copy To (see the screenshot 
below).  

 

 
 

When clicked, the Copy To button displays the Copy Item To dialog. In the dialog, select the 
location where you want to copy the item and click the Copy button (see the screenshot below).  

 

 
 

The item will be copied to the destination location you specified.  

The Copy To command also allows you to copy the item to another database. Click the little 

triangle to the right of the Copy To button to display the Transfer to Other Database command 
(see the screenshot below).  

 

When clicked, the Transfer to Other Database button will start the Transfer item wizard. Follow 
the wizard to successfully complete the transfer process.   

6.1.5.1.2 Via the Clipboard 

Open the Content Editor and locate Home tab » Clipboard chunk » Copy (see the screenshot 
below).  
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 Select the Copy button to copy the item to the clipboard. Select the destination location for the 
item and click the Paste button on the Clipboard chunk  

 

The item will be pasted to the location you specified.  

6.1.5.1.3 Via the Right-Click Menu 

You may access the Copy and Paste clipboard commands via the menu available upon right 
clicking the item (see below). 

   

Open the Content Editor and locate the item you wish to copy.  

Right click the item and select Copy from the menu which will appear. Then select the destination 

location for the item to be copied to and select Paste from the menu. The item will then be pasted 
to the location you specified.  

You may also select Copying » Copy To in the same menu (see below).  
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This will open the Copy Item To dialog. In the dialog, select the location where you want to copy 

the item and click the Copy button (see the screenshot below).  

 

6.1.5.2 Duplicating Items 

There are two ways to duplicate items in Sitecore.  

6.1.5.2.1 Via the Duplicate Command 

Follow the steps below to duplicate the item: 

Open the Content Editor (select Sitecore » Content Editor). 

Locate Home Tab » Operations Chunk » Duplicate (see below). 

 

In the content tree, select the item you wish to duplicate and click the Duplicate.  

Enter the name of the new item in the Explorer User Prompt which will appear and click the OK 

button (see the screenshot below).   
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The new item will appear in the currently selected folder (see the screenshot below).  

 

 

6.1.5.2.2 Via the Right-Click Menu 

Locate the item you wish to duplicate in the content tree and right click it.  

Select the Duplicate command in the menu which will appear (see the screenshot below).  

 

 

Enter the name of the new item in the Explorer User Prompt which will appear and click the OK 

button (see the screenshot below).   
 

 

The new item will appear in the current folder (see the screenshot below).  
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6.1.5.3 Moving Items 

Sitecore offers several ways to move the item.  

6.1.5.3.1 Via the Move To Command  

Open the Content Editor.  

Select the item you want to move and click the Move To button located on the Operations chunk 
of the Home tab. 

 

In the Move Item To dialog which will appear, select the location where you want to move the 

item and click the Move button (see the screenshot below). 

 

 
 

The item will be moved to the destination you specified.    

6.1.5.3.2 Via the Right-Click Menu  

You may also follow the steps below to move the item to another location:  

Open the Content Editor. 

Locate the item you want to move in the content tree and double-click on it.  
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In the menu which will appear, select Copying » Move To (see the screenshot below).  

 

 

In the Move Item To dialog which will appear, select the location where you want to move the 

item and click the Move button (see the screenshot below). 

 

 
 

The item will be moved to the destination you specified.  

6.1.5.3.3 Via Dragging    

You can simply drag and dorp the item to move it to another location.     
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6.1.5.3.4 Via the Clipboard   

You may also use the Clipboard Cut and Paste commands to move the item to another location 
(see the screenshot below).  

  

6.1.5.4 Deleting Items 

There are two ways to delete items. 

6.1.5.4.1 Via the Delete Command 

Firstly you can use the Delete button on the Home » Operations Chunk (see below). 

 

Select the items to be deleted and click the Delete button. 

6.1.5.4.2 Via the Right Click Menu 

Locate the item you want to delete and right-click on it. In the menu which will appear, select the 

Delete command (see the screenshot below).  
 

 

The prompt asking you to confirm deletion will appear (see the screenshot below). Select OK to 

confirm that you want to delete the item or Cancel to cancel the action.  
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6.1.5.5 Renaming Items 

There are two ways to rename items. 

6.1.5.5.1 Via the Rename Command 

Select the item to be renamed and click on the Rename button on the Home » Rename Chunk (see 
below). 

 

You will then be prompted to give the item a new name (see below).  

 

Once this action is completed click OK and the item will be renamed. 

6.1.5.5.2 Via the Right Click Menu 

Locate the item you wish to rename and right-click on it.  

Select Rename in the menu which will appear (see the screenshot below).  

 

 

Enter the new name of the item into the appropriate field of the prompt which will appear and 
click OK (see the screenshot below).  
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6.1.5.6 Sorting Items 

There are two ways to Sort items. 

6.1.5.6.1 Via the Sorting Chunk Commands 

The Sorting chunk displayed when you select the Home tab in the Content Editor contains 
commands which allow you to define the order in which the items are shown in the item list (see 

the screenshot below).  

 

Refer to The Sorting Chunk section of the Content Editor article for the detailed description of the 
sorting commands available.  

6.1.5.6.2 Via the Right Click Menu 

Locate the item you wish to rename and right-click on it.  

Select Sorting in the menu which will appear (see the screenshot below) then select the sort 

operation you wish to perform on the item. 

 

 

6.2 Logs and Statistics 

To provide Administrators with thorough statistics concerning the activity on a web server, 

Sitecore records the Log file and the Audit file. The Log file basically lists the actions that have 
occurred on a site, while the Audit file keeps track of user activity.  

6.2.1 Logs 

To provide Administrators with thorough statistics concerning the activity on a web server, 
Sitecore records the Log file and the Audit file. The Log file basically lists the actions that have 

occurred on site, while the Audit file keeps track of user activity. 
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6.2.1.1 The Log Viewer 

The Log Viewer is used to open, download and display the Sitecore log files. All log files are 

stored in the /data/Logs/ folder and have the date as an extension.  

It can be accessed by selecting Sitecore » Reporting Tools » Log Viewer.  

 

When selected the Log Viewer screen is opened (see below). 

 

6.2.1.1.1 The Toolbar 

The toolbar of the Log Viewer consists of the following buttons:  

   Click to open a log file. 
Note: Some setup may be required to view the log files. Please, see the Configuration section. 

   Click to download the currently selected log file as a 

standard .txt file. 

   Click to delete currently selected file. 

   Click to refresh the log and see the latest entries.  

Note: the Download and Delete buttons are visible even if no file is loaded. An appropriate 

message will be shown if they are pressed when no file is open.  
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6.2.1.1.2 The Workspace 

The workspace of the Log Viewer consists of lines of text with statistics.   

Each line includes the following information: 

 The event source with its thread number or the Process ID. 

 The time when the event occurred. 

 The level of importance. 

 A short event description.   

 

6.2.1.1.3 Configuration 

This section describes how to configure where the log files will be stored. 

The location of the log files and their naming is defined in the <log4net> section of the 

web.config file. 

The log files may be stored inside or outside the Sitecore root folder. 

To assign the folder where the log files will be stored, please, do the following:  

 Open the web.config file.  

 Find the <log4net> section and edit the <file value… /> definition. Enter the path to the 

folder where you want your log files to be stored.  

The file element defines the location of the log files. This location must be the same as 

the setting in LogFolder The file element is a relative or absolute path that always uses 
slashes (/) as separators. A valid file element for a relative path would be:  

<file value="$(dataFolder)/logs/log.{date}.{processid}.txt" /> 

 A valid element for an absolute path would be:  

<file value="C:/inetpub/wwwroot/data/logs/log.{date}.{processid}.txt" /> 

To assign the folder where the log files will be read from, please, do the following:  

 Open the web.config file.   

 Find the <setting name="LogFolder" value="$(dataFolder)/logs" /> definition and change 

it to the appropriate value.   
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 Note: the log files can only be read from a location within or under the Sitecore root 

folder. 

6.3 Troubleshooting 

Nothing is perfect in this world and unexpected issues sometimes happen even to the most 
reliable systems. This section provides information on resolving issues when they occur with 

Sitecore.  

6.3.1 Diagnosing Problems 

The common complaint about help desks or manuals is that they sometimes first ask: "Is it 
plugged in?" This should not be taken as an insult; rather it should serve as a reminder to always 

check the simple things first before calling for help. 

6.3.1.1 Don’t Panic 

The common complaint about help desks or manuals is that they sometimes first ask: "Is it 
plugged in?" This should not be taken as an insult; rather it should serve as a reminder to always 

check the simple things first before calling for help.  

6.3.1.2 Isolate Possible Causes 

A process of elimination is most often used to isolate possible causes of problems.  Usually 
troubleshooting is applied when something has suddenly stopped working, so the first focus 

should be on what has changed. A basic principle in troubleshooting is to start from the simplest 
and most probable possible reasons of problems first. Try to answer the following questions:  

 What has changed?  

Has an add-on recently been installed? Did the server configuration change? Was the 

web.config file changed?  

 What leads to the error?  

Try to reproduce the error step by step and analyze what happens during each step. Try to 

determine at what point the problem is occurring.  

 How can the error be reproduced?  

Try to remember all of your last actions before the problem occurred. Formulate an exact 

scenario to reproduce the problem. You will need this information to report a problem to 
Sitecore support team.  

Analyze the Log file for the last day. Sitecore Logs record a lot of useful information concerning 

the activity on a web server. Pay special attention to the time period when the problem occurred.  

6.3.2 Missing Content 

If content is missing from the published web site, check the following:  

 Have you saved the Item before publishing?  

In most cases you will be prompted to save an edited item before publishing, but even so 
it‟s a good practice to save items periodically while working.  

 Is the Item in a workflow but not in a final state?  

Remember that when an item that is in a workflow is edited, its new version is created 

and put to the initial stage of the workflow . An appropriate user must approve the 

changes in this new version before it is published.  

http://sdn5.sitecore.net/SDN5/End%20User/Site%20Administration/Troubleshooting/Reporting%20Problems.aspx
http://sdn5.sitecore.net/SDN5/End%20User/Site%20Administration/Troubleshooting/Reporting%20Problems.aspx
http://sdn5.sitecore.net/SDN5/End%20User/Site%20Administration/Troubleshooting/Reporting%20Problems.aspx
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 Is the Item provided in the requested language?  

Check the list of languages and make sure that you edit/view the appropriate version.  

If you are sure that the language was set correctly during editing, try to publish the site 
again and make sure that the desired language is selected:  

 
 Does the visitor have access rights to view the item?  

Keep in mind that if a user is assigned more than one role, the general conflict resolution 

rule shall apply. This is; 

 When rights assigned to separate roles conflict the right will be denied. 

 Is the rendering coded correctly?  

Examine the XSL code step by step. Eliminate all the code not related to the item in 

question. If the content was present before, but disappeared suddenly, try to remember 

what has changed.  

 Is the Item available in the Web Database?  

Please read the next section View the Published Site.  

6.3.2.1 View the Published Site 

The Web database contains the published web site, thus you can see what exactly has been 
published in it.  

The Web database is accessed in the following way:    

Click the database icon in the lower-left corner of the Sitecore Desktop and select „web‟:  



 

Sitecore Using Sitecore Page 113 of 119 
Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2007 Sitecore. All rights reserved. 

 

The Web database will become active.    

Open the Content Editor and access the content folder. Now you can see the items that are 

actually present on the target site. If the desired item is missing, try the following:  

 Try to publish one particular item. 

Use the Publish button of the Publish Tab » Publish chunk (see below).  

  

 Try to do a Full Publish.  

 Check whether the Item‟s Never Publish toggle is enabled.  

 Are the Item‟s Publish and Unpublish dates set correctly?  

6.3.2.2 Transferring Manually 

Note: It is better to not edit the web database manually. You should use this option as a last 
resort.    

If an item is missing that you believe SHOULD have been published, you can manually publish 

it:  

 Select the Item in the Content Editor in the Master Database.  

 Right-click the Item and select Copying » Transfer (see below). 
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 The wizard walks through the process of copying the item to the Web database.  

 
 Screen 1: Review the info and click Next. 

  
 Screen 2: Select the source item (the one you wish to transfer). The item that has been 

selected before the transfer command was called is chosen as source by default.  
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 Screen 3: Select the web database from the list.  

 
 Screen 4: Select the destination item. The source item will become a child of the 

destination item.  
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Screen 5: Operation summary. Check Include subitems if you wish the subitems of the 
source item to be copied as well. Click Next to transfer an item.  

6.3.2.3 Restoring Deleted Items 

Please, refer to the Recover Deleted Items section for instructions on how to restore deleted items.  

6.3.3 User Cannot Edit an Item 

The following list suggests possible causes, starting with the simplest and most probable.  

 Did the user select the Edit button?  

Only Administrators can edit items without enabling the action. All other users must 

select the Edit button ( ) to lock the item before they start editing something.  

 Does the user have access rights to the Item?  

An Administrator can use the Access Viewer to check whether a user has write 
permission for an item. If a user cannot see the item at all, it may mean that the Read 

permission is also denied. 

 Has someone else locked the Item?  

Only one user can edit the item at a time.  

 Is the Item in a Workflow State that the user does not have access to?  

Security rights can be influenced by the workflow mechanism. When an Item is in the 
workflow, effective security permissions for users in some cases will be determined by 

the current workflow state of the Item. For example, if an item is in the Approving state 

of the Simple workflow, a user must have write permissions for the Approving state in 
order to be able to modify the item.  

For instance, an item submitted by an editor to the next workflow stage will not be 

accessible for this editor until someone returns it to the initial state. Please, refer to 

the Workflow Commands section for more information.  

6.3.4 Restarting Components 

When nothing seems to help and the system behaves strangely, restarting may resolve some 

issues.  
Note: the following statements are related to the server environment.  

Restart the following components one at a time and check the results after each attempt:  
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6.3.4.1 ASPNET_WP.EXE process.  

 Start Windows Task Manager (e.g. by pressing Ctrl+Alt+Delete).  

 Select the Processes inlay and choose aspnet_wp.exe from the list.  

 
 Click the End Process button. aspnet_wp.exe will restart automatically.  

6.3.4.2 IIS (Internet Information Service).  

 Start the Run console (Start» Run).  

 Run the iisreset command (type in iisreset and click OK).  

 
IIS will restart.  

6.3.4.3 The Server.  

Warning: use this method as the last resort only! Notify everyone who uses the server before 
restarting.  

 Restart the server. 
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6.3.5 Reporting Problems 

If all attempts to solve the problem locally didn‟t lead to success, contact your Sitecore partner or 
the Sitecore Support Team if you have a direct support agreement.  Please, refer to the Collecting 

Information section for instructions on what information should be sent along with your support 

case. Sending the relevant information improves the turnaround time for your case.  

6.3.5.1 Collecting Information 

To make the process of troubleshooting run faster, it is crucial to provide technical specialists 
with as much information about the problem as possible. Below is the list of the most useful 

things to include.  

General Note: Please remember that all support enquiries directed to Sitecore Support must be in 
written English.  

Instructions for reliably reproducing the problem.  

 In reality it is almost impossible to work out a problem that is impossible to reproduce. 

Try to remember all of your last actions before the problem occurred. Formulate an exact 
scenario to reproduce the problem. Scenario instructions must be clear, well-defined and 

detailed – this will save you time and effort.  

Step by step instructions are a good way to go.  

 Relevant Sitecore data files. 

 Please consider providing your partner or the Sitecore Support Team with the following 

information (provided this information is pertinent to your case):  

 

Note: It is highly recommended that you send all files packed into a ZIP file.  

 
If you experience any problems with clean Sitecore CMS (not with modules) you should 

include the following:  

o Sitecore Version. You can find the Sitecore version in the About box (Sitecore» 
All Applications » System » About Sitecore)  

o  
o The web.config file (located in the Sitecore web root folder).  
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o The Master Database:  

o For the SQL edition: you should backup the relevant Sitecore databases (contact 
your database administrator if you are unsure how to do this), package the results 

into a zip file and upload it to an FTP server or somewhere on your site so that 

the Support Team will be able to download it  
o (for example, http://www.companysite.com/upload/databases.zip). 

o For the Firebird edition: package the Firebird database files into a zip file and 

upload it to an FTP server.  

o Log file for the last day (log.*.txt) from the Data folder. Click here to read more 
about Log files.  

o Audit files (audit.*.txt) from the Data folder. Click here to read more about Log 

files. 
o If you experience any problems with Sitecore modules, you should send module‟s 

log files (if any) as well:  

o Module‟s log files:  

StatCenter: /sitecore modules/StatCenter/logfiles/* 
Maintenance: /sitecore modules/maintenance/log.txt 

Stager: /sitecore modules/staging/workdir/*.log 

o Screen shots whenever possible 
Sometimes one look at a screenshot is worth a dozen of lines of explanation. If 

the problem has any visual display – don‟t hesitate to make screenshots. It‟s a 

good practice to highlight the parts of a screenshot that require special attention.  
Note: please, make sure that screenshots provide sufficient resolution and are 

compressed in a suitable way. 

o Copies of any error messages you get  

o The Support team will appreciate any additional information which you think wil 
help them to help you.  

http://www.companysite.com/upload/databases.zip
http://sdn5.sitecore.net/SDN5/End%20User/Site%20Administration/Logs%20and%20Statistics/Logs.aspx
http://sdn5.sitecore.net/SDN5/End%20User/Site%20Administration/Logs%20and%20Statistics/Logs.aspx
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